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Intro to Word 

 

Hi, I’m Maria. I’m going to show you how to use Microsoft Word. We’ll be 
following along with Jane, who wants to use her computer to type letters to family 
and friends.   
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Microsoft Word is usually referred to as simply “Word”. It’s a word processing 
program. A word processing program allows you to type and create documents, 
such as resumes, letters, reports, and more. You can use Word to create any 
text based document on your computer that you can print out or send 
electronically in an email.   
 

 

Word has features that allow you to check spelling and grammar, change the font 
and sizes of your text, and to add bullet points. Word is installed on many 
computers, but if you don’t have it on your own computer, you can purchase it 
and install it. 
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To open Word, Jane must first locate it. When Jane looks at her computer 
desktop, she can see several icons. Often, a computer will have an icon for Word 
right on the desktop. Once Jane locates the icon, she can double click on it, and 
the Word program will open.  
 

 

The blank white page that comes up when you open Word is where you can 
type. It is the same as starting with a blank piece of paper on your desk, except 
that the paper is now electronic and on your computer.  Word automatically sets 
up margins on the top, bottom and sides of the page, so when you type, 
everything will fit correctly. 
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To start typing, Jane moves the mouse arrow to the white page and clicks.  
 

 

Jane starts typing her letter. When she wants to move to a new paragraph, she 
hits the ENTER key.  
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When Jane is typing, she sometimes sees a red or blue line under a word or 
sentence. When the line is red, it means that Word noticed a misspelling. When 
the line is blue, it means that there is a grammar error. There are two ways that 
you can see suggestions to fix these problems. 
 

 

First, you can right click on the underlined word.  
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When Jane right clicks on the red underline, Word shows suggestions for 
correction.  
 

 

Jane can click on the correct spelling, and Word will replace the misspelled word.  
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Jane can also click on the blue underline to get a suggestion for grammar 
correction. 
 

 

Once Jane has typed more, she can check spelling on the entire document at 

once.  To do that, she clicks on the Review tab at the top of the Word menu.   
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When the new menu bar opens, Jane can click on Spelling & Grammar on the 

top left. Word will start looking for any misspelled words, or improper grammar.  

 

 

The spell check screen will display possible corrections.  Jane can click on 

Change to automatically change them in her document.   
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Jane can also ignore the corrections if she wants to, by clicking on the Ignore 

button. Sometimes you will spell a word correctly, but Word will not have the 

word in its dictionary.  

 

 

When you’re done, you’ll see a popup that tells you the spelling and grammar 

check is complete.   
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Click on OK to finish. 
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Saving Your Work 

 

Saving your work is a good idea, even when you aren’t finished creating your 

document. When Jane saves her work, it prevents it from being lost if there is an 

error or if the computer stopped working. There are two ways to save your work 

when using Word.  

 

The first way Jane can save is by clicking on the File tab on the top left of the 

screen.  
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When the menu opens, Jane can either click Save or Save As. Both options will 

save the work. When Jane saves something for the first time, she will be asked 

to name the file and place it in the location of her choice.  

 

 

When Jane clicks on Save As, she can save the document anywhere on the 
computer or even on a flash drive with this option. You just need to remember 
where you saved the file!  
 
In this version of Word, Jane clicks on Browse.   
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You can see that she’s now in her Documents folder.   
 

 

Jane has the additional choice of choosing what type of file she would like to 

save her document as. The best idea is to save the file as a Word Document, 

which is the default option. It’s important to note that before you choose any of 

the other file options, be sure you understand what type of file you are saving it 

as. Saving something as the wrong file type can prevent you from opening the 

document the next time you need it.  
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Now Jane can type in a file name for her document. Jane can name the file 

almost anything she wants! There are some characters that can’t be used in a file 

name, including special characters like percent signs, or dollar signs. Word will 

alert you if you try to use special characters that aren’t allowed. 

 

 

Jane types in her file name, and then clicks on the Save button to save the file. 
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After Jane first saves her Word document, she can continue to hit either Save 

using the File tab or she can also simply click on the Save icon on the top menu 

bar.  This is the icon looks like a floppy disk.   

 

When Jane clicks on the Save Icon, she will not be prompted to name the file or 

pick the location where it saves. The file will automatically be saved with the 

same file name and to the same location she chose before, since she has 

already saved it once.  

 

Try to save your work often, saving several times when you’re working on your 

document, and anytime you take a break.  

 

 

 



   

1 

   

Formatting 

 

Word allows you to change how your document looks, especially with the type. 
The “Font” menu has options to Bold text, to italicize text, to underline text, to 
change font face and size, and to change the color of text.  
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Bold 

 

Let’s take a look at some text being formatted.  First, you need to select the text 

you want to format.  

 

 

In some versions of Word, the font menu pops up when you select text to format.  
Now we’ll bold this selected text by clicking on the B icon. 
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Italicized 

 

 

Now we’ll select some text, and click on the I icon to italicize the text. 
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Underlined 

 

 

Next, we’ll select text, and click on the U icon to underline the text.  
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Changing Text to a Different Color 

 

 

 

Finally, we can select text, and click on the dropdown next to the colored A to get 

a color picker.  
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This will change the color of our text.  

 

Just remember, there’s a time and a place for different colors and other 

formatting. It’s important not to go overboard! 
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Let’s get back to Jane and her letter.  One bit of formatting Jane wants to do is to 

make the text size a little bit bigger.  If Jane wanted to, she could have changed 

the font size before she started typing, by changing the font size option at the 

beginning.   

 

Now that Jane has typed the letter, she can still change the size of the font, but 

she needs to select all of the text, and then change what’s selected. 
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There are two ways Jane can select all the text in her document. She can use 

the click and drag method, where she clicks the top of the page, continues to 

press on the left button on her mouse, and drags the mouse all the way down to 

the end of the page, and then lets go of the mouse button. When she does that, it 

will highlight everything that she’s typed.   
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Jane can also use a keyboard short cut to select all the text, by holding down the 

Ctrl key and the A key at the same time. This will highlight all the text on the 

Word document. This is an easier option if you want to select the whole 

document, since clicking and dragging can be hard to do with a lot of text.  Once 

Jane has highlighted everything, she can use the font options to change the font 

style and the font size. 
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When Jane clicks on the arrow next to the drop down menu, she can view all of 

the available font styles. Jane can get a preview of what the font style looks like, 

because the name of the font style is in that font.  Jane selects a font style by 

clicking on it from the drop down menu, everything that he has highlighted will 

now be in the new font style.  
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Everything that she has highlighted will now be in the new font style. Jane can 

change the font as much as she’d like. She can even change the font style for 

individual words, sentences, or paragraphs. She can just click and drag to select 

whatever text she wants changed.   

 

 

Jane also wants to make the letters a little bigger. She clicks on the dropdown 

arrow next to the font size box. This will allow Jane to view and pick a font size, 

just like she did with the font style.  
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Cut, Copy and Paste 

 

A helpful feature of Microsoft Word, and many other programs, is the ability to 
cut, copy, and paste.  These features allow you to take text or images from one 
document or file on your computer, and add them into another document or file.   
 
You can copy almost any text or image on a computer to paste it into a Word 
document. Let’s see these features in action with Jane’s letter. 
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Jane has decided to change the order of paragraphs in her letter. To do that, she 
will use the cut and paste features in Word. 
 

 

To cut and paste, Jane needs to use the click and drag method again to highlight 
the text she wants to move.  
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Once the text is highlighted, Jane will go up to the Clipboard menu. Since Jane 
wants to move this text, she selects the Cut option, which looks like a pair of 
scissors.    
 

 

You can see that the text disappears.  It’s now on the Clipboard, waiting to be 
pasted.   
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Now Jane clicks to the area where she wants to move this paragraph, and clicks 
enter to make room. 
 

 

Then Jane clicks on the Paste icon, which looks like a clipboard. 
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The text is pasted in the spot Jane selected. All she has to do is delete the extra 
space, and she’s finished moving the text.  
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Another feature is Copy. This feature lets you keep the text or image in its 
original place, while making a copy to insert in another place.   
 
Jane wrote a letter a few months ago, where she described her granddaughter’s 
birthday party to a friend. She has decided to include this same text in the letter 
she’s currently writing. Jane now has that letter open on her computer. 
 

 

Jane selects the text in the letter that she wants to copy, using the click and drag 
technique. 
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Once the text is selected, she clicks Copy on the clipboard menu. The icon looks 
like two documents stacked on top of each other.   
 

 

You can see that the text being copied stays in the document, since Jane is 
using the Copy feature, not the Cut feature.   
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Now that the text is copied to the clipboard, Jane minimizes the old document to 
go back to her letter.   
 

 

She clicks where she wants the text to go, 
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and then clicks on the Paste icon on the clipboard menu.  The text from the old 
letter is now pasted into the current letter. 
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Insert a Picture 

 

Jane is almost done with her letter, but she would like to include a picture. To do 
this, she clicks the place in the document where she’d like the picture to go. 
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Then she clicks on the Insert tab on the top menu.   
 

 

As you can see in the insert menu, Word allows you to insert pictures and many 
other things, including shapes, links, tables, graphs and more. 
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To insert a picture, Jane clicks on the Picture icon.   
 

 

Word then opens a window that will let Jane browse to the image on her 
computer that she wants to use.  
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Word has automatically opened the Pictures window, where the image Jane 

wants to use is located. 

 

She clicks on the image, and then clicks on Insert to insert it into the letter. 
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The image now appears in the letter, but the text isn’t flowing around the image.   
 

 

Jane just needs to click on the layout options to change this. 
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She selects the Square option to have the text move to the right of the image. 
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Now here letter looks just right, and she’s ready to send it! 
 

 

 


